
Getting Started with Thunder Laser - Keychain
Project

This guide is a concise compendium of information for projects using the Thunder Laser.

Written By: Alan
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INTRODUCTION

This guide is a concise compendium of information for projects using the Thunder Laser. After
completing this tutorial you will have learned how to use the Thunder Laser for simple project by
making a key chain.

TOOLS:
laser cutter (1)
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Step 1 — Location: MakerE

The Thunder Laser is located in the
MakerE in Dana 111.
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Step 2 — Safety Information

 

Any use of a laser cutter is potentially hazardous. Materials can catch on fire, disabling machine
interlocks can potentially expose you to laser radiation capable of blinding you, and cutting the
wrong materials can release toxic gasses.



Before you start cutting know where the fire extinguisher is in case materials catch on fire.

If you are unsure if a material is safe to cut, ask first. Many plastics contain chlorine or fluorine and
materials like PVC, vinyl records, and Teflon are never safe to cut.



You must keep an eye on the laser cutter during any cuts in case there is a fire. Leaving the
immediate area during a cut is a violation of the MakerE User Agreement and may result in
penalties up to permanent expulsion from the space.
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Step 3 — Materials for Laser Cutting

 

Check the bin below the Thunder laser first to see if you can use has already used material. It is
wasteful to always use fresh stock when working on a project. Whenever possible you should sort
through the used stock in the blue bin underneath the plywood table.



For this project you will need a piece of material with an area about 3" x 3" square.

Grab a ruler and measure the remaining areas on scrap material to see if your project will fit on
one or more pieces of scrap.



If your work is too large to fit on scrap then feel free to use new stock located on the shelves near
the laser cutter.



If you are doing preliminary cuts or simply testing a design we recommend using cardboard rather
than wood or acrylic. It is cheaper and faster.



Again, if you are not sure what is safe to cut, check with a MakerE Tech!
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Step 4 — Check the Cooler

 

Every user should check the following before turning on the Thunder Laser:

Make sure the switch on the chiller unit below the laser is turned to the on (I) position.

MakerE Techs: Every week check the back of the chiller to make sure the water level is in the
green region. If it is not stop you will need to fill the chiller with distilled or RO water.



Only after you have checked the switch and made sure it is on are you ready to turn on the
laser cutter.
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Step 5 — Turning on the machine and moving the head and bed

 

Before you turn on the Thunder Laser make sure your access card is in the Portal Box and it is
green.



Do NOT start the LightBurn software yet since it may throw an error if it cannot find the laser.
You must turn the laser on before starting the software.



Turn on the Thunder Laser using the Main Switch which is the upper of the two switches on the
right side of the machine.



DO NOT turn on the lower, Laser, switch yet since that turns on the laser tube. For safety leave it
in the off, O, position for now.



Once the machine is on you can move the laser head by using the four arrow buttons shown. The
two other arrow buttons move the bed up and down.



Move the laser head to the back, left position and drop the bed so you can load your material
without hitting the laser head.
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Step 6 — Check which head is on the machine.

 

Cutting settings are in the PDF document attached to this guide. Scroll to the bottom to access the
file.



Note that we have several different laser heads that will affect cutting power and speed so verify
which head is currently on the laser before cutting. The spot size and focal lengths vary.



The standard head is for most cutting and has a laser spot size of 0.0039 inches or 0.1 mm
and focal length of 5 to 6.5 mm.



The 4 inch head is to cut materials over 10 mm thick and has a laser spot size of 0.008 inches
or 0.2 mm and a focal length of 9 to 11 mm.



The high resolution head is for engraving photos up to 1000 lines per inch. It will only cut
materials 1 mm thick or less, has a 0.002 inch or 0.05 mm focal spot with a 3-4 mm focal length.



If the head on the machine works for your job skip ahead to step 7, otherwise change the head as
described in the next step...
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Step 7 — Changing Air Nozzles (usually skipped)

 

You will want to use the standard nozzle for almost all your cutting so if that nozzle is installed you
can skip this step.



To change the nozzle first remove the air hose by pushing down on the ring around the fitting and
gently pulling up on the hose. It should release easily.



Then loosen the brass release screw knob about half a turn once the air hose has been
disconnected, and slowly lower the nozzle to pull it out. If the bed is too high you'll have to jump
ahead in the tutorial to learn how to lower the bed.



Put on the new head, making sure to reattach the air hose. It should just slip into the fitting.
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Step 8 — Inserting Material

  

If you have not done it yet, use the arrow keys or origin button to move the laser head to the back
of the unit.



Slide material in making sure not to bump the head

Check to make sure your material is flat. The area of the laser focus where it will cut well depends
on the nozzle you use, but is generally only a few mm. If your material is warped more than a few
mm it may not etch well or cut all the way through.



Use the magnets which will be somewhere on the case of the laser to hold the material flat if
necessary.



If you use magnets make sure they are out of the path of the laser head!
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Step 9 — Setting the Laser Focus

 

Using the arrows on the control panel raise the bed so the top of your piece is about 6 mm below
the tapered bottom of the laser head.



Using the triangular focal tool (see image) try to slip it between the laser head and work piece. It
should just barely slide in.



If it is 'way off use the control panel buttons to adjust the height of the bed. If it is close then release
the brass knurled knob on the laser head (see photo) slightly and move the head so it just touches
the workpiece.



This sets the focus properly - remove the focus tool and you are ready to go!

Getting Started with Thunder Laser - Key… 2022-01-20[minor]v 1.2Release:Guide ID: 170 -

This document was generated on 2022-02-02 05:24:09 AM (MST).

© 2022 bucknellmakers.dozuki.com/ Page 11 of 28



Step 10 — Start the LightBurn Software

 

Begin by inserting an authorized makerspace card into the Portal box BEFORE launching the
software.



Login to the computer next to the laser cutter using the following credentials:

Login: makerquip

Password: BucknellMaker-3

Open the LightBurn software from the computer desktop.

For this tutorial we will create a Bison keychain fob. Click to download the Bison Keychain file .

I chose to make this one out of leather, but you can choose whatever material you wish.

Note that the laser cutter can process vegetable tanned leather but not chrome-tanned (often
colored) leather since it will release toxic chemicals!
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Step 11 — Overview of Lightburn Software

The Lightburn software interface is
somewhat intimidating since it
supports a lot of features. The next
few steps will walk you through the
basic steps of cutting and engraving.
For a more in-depth exploration see
this tutorial.



The image shows the various parts
of the Lightburn software work area.
To import then engrave or cut your
project you will have to:



Import a .svg file for cuts and
engraves, or an image file if you
just want to engrave using the file
menu.



Make any modifications to the file
such as changing the size,
adding text or shapes, etc. using
the tools on the left of the screen.



Assign power and speed levels to
the layers on the drawing
(different colors correspond to
different layers) that match with
the material you are cutting or
engraving. You may have to
change colors using the color
palette.



Put the layers to cut in the right
order - this is important and not
doing so can ruin your project.
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Set cutting parameters such as
airflow in the layers section on the
upper right.



Send the job to the ThunderLaser
using the controls on the lower
right.



Step 12 — Importing the File into Lightburn

Use the File → Import menu to load
the keychain .svg file.



If you would like to create a different
design that is discussed in the next
(optional) step.



In the keychain file there are three
different colors which tell the laser to
use different speeds and powers.
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Step 13 — Optional - Using your own image

If you would like to use your own
image for the keychain then import
the image into Lightburn. It should
be high contrast black and white or
greyscale, and sized to fit on the
keychain you would like to make.



Refer to steps 5-8 of the Glowforge
tutorial for creating your own design
in Inkscape or other software.



After the image is loaded use the
box or circle tool in LightBurn to
make a border around the image.
This will be the outer diameter which
is cut by the laser.



Make sure to leave room for a hole
for the keychain to go through.



Add a hole about 0.2 inches in
diameter inside the border.



Using the select tool, click the
border then go to the color palette
and click on a different color than
the image, here it is blue. The
border should turn this color.



Do the same for the hole, using a
third color that is different than the
image or the border, in this case
green.
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Step 14 — About colors, cuts, and order

 

Different laser powers and speed for example cutting and engraving are represented by different
colors in the image.



The order in which cuts happen is very important. For example if you cut out the outline of your
project first, it is likely the air shooting out of the nozzle will move your part around, ruining any
image.



For this reason, make sure any frames or outlines of the drawing which if cut separate your work
from the substrate material are different colors than the rest of the cuts.



In the image shown there are three layers (blue, black, and red) each with different laser
parameters.



If you need to set the colors after importing a file, you can use the select tool (arrow at the top of
the left tool bar) to select part of your drawing then the color palette at the bottom to set the color.



If you cannot select just the outline, then you will have to go back and fix your file before you
can cut.



Depending on how the windows are set up in LightBurn you may be able to easily switch between
the Layers menu and the Laser menu using the tabs as shown in the second image.
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Step 15 — Choosing cutting powers and speeds

Doing a successful cut or engrave
depends on setting the right cutting
power and laser head speed.



The linked PDF document has
suggested power and speed settings
for common materials for this
particular laser cutter (Nova 24).
You should open this now to make
sure your settings are correct!
Download the speeds and settings
guide.



There are settings for engraving
images and separate settings for
cutting materials. Make sure you
choose the right ones!



Materials are not ideal so these
settings are good starting points but
won't always work. Plywood or MDF
particularly have a lot of variation
between pieces. We recommend
doing a small test cut or engrave
and dialing in settings before starting
a big project!



Not all materials can be processed
on a laser cutter and some materials
such as PVC plastic or chrome-
tanned leather can release toxic
and/or corrosive chemicals. If you
are not sure about a material being
safe ask before you cut!



Many plywood in MakerE is of 3mm
that's not showing on the docs. Use
Speed: 32 mm/s Power: 90%
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Step 16 — Set cut powers and speeds

  

Once you have your file in Lightburn and all the various parts that need different cut speeds and
powers in different colors, the next step is to assign powers and speeds to each layer.



Each color corresponds to a different layer. Note you can also set whether the laser is on or off
for a layer, or also the air setting (on = high, off = low).



Find the Cuts/Layers menu window shown in the figure. If it is not visible then open the Windows
menu at the top and make sure it is selected. If it is uncheck it then check it again and it should
appear.



In the menu window you will have one line for each of the layers (colors) in your figure. On the first
figure there are three layers: blue, red, and black.



There are two ways to set the power and speed for each layer.

The first, recommended way is to double click on each entry in the Cuts/Layers menu window
and set the correct power and speed from the PDF guide. This is shown in the second image.



The second way is to assign a material from the Library window to each layer. Make sure the
layer is highlighted then go to the Library window, find the material, and click "Assign to layer"
as shown in the third image



Note that the powers and speeds in the library may not be correct so make sure you double
check them with the Thunder Laser settings table!
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Step 17 — Set the order of cuts and engraves

 

Before beginning your cut you will have to make sure the order of cuts and engraves is correct.

The layer (color) at the top will be cut first, and the one on the bottom last.

Make sure any outlines that will disconnect the piece you are cutting out from the main body of
your material are *last* in the cutting order.



Cutting the piece out first may cause it to move midway through cutting, ruining the project.

Small pieces may even be blown out of the path of the laser, potentially getting stuck and
then hit by the laser head.



Make sure that the Mode setting (see second image) matches what you want the laser to do. Cuts
should be set to "Line" and engraves to "Fill".



If the line on your drawing is thick and the mode is set to fill, the laser may do multiple cuts, which
creates a fire hazard!
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Step 18 — Use camera to verify placement

  

The Thunder Laser is now equipped with a camera to help with the placement of your cut. This
step is important to make sure your cut will actually fit on your material.



DO NOT physically move or adjust the camera. The camera is designed to be used only with the
lid open. You usually won't have to recalibrate the camera every time you use it but if you move it
you will have to.



In the Windows drop-down, make sure that "Camera Control" is selected. It will appear on the left
as a tab. You may need to exit whatever current window is open for the tab to appear. Select it,
and you should see a live feed of the laser bed from the camera.



With the Camera Control window up, verify that you can see your material in the live feed. Click the
"Update Overlay" button to set the background of the workspace to a captured image from the
laser bed.



If the overlay image seems excessively crooked or distorted, find the lab director or a tech to help
you follow the built-in tutorial to recalibrate the camera.



Select and drag your image to where you want it cut. You can scale and rotate as needed if
necessary.
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Step 19 — Fire up laser and upload file to laser

 

If you encounter a communication error, stop and make sure your Maker card is in the
Portal box and you are authorized to use this laser cutter. You must insert a makerspace card
BEFORE launching the LightBurn software!



Turn on the lower laser switch on the side of the Thunder Laser that you left turned off earlier. It
now time to BURN!



Using the Laser window (you may have to turn it on by clicking Window → Laser) upload the file as
shown in the second image by clicking the Send button.



You should see a progress bar appear. If you are not authorized to use the laser cutter the file
won't upload.



Make sure the file loads correctly and no error windows appear in Lightburn. An incorrect file
upload can ruin your project.
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Step 20 — Optional - Setting Air Assist

For most cutting jobs this step is
optional since the airflow will already
be set correctly. If you need to set
the air flow continue reading, if not
skip to the next step.



In some cases where you are cutting
particular materials or engraving at
high resolution, you may need to set
the amount of air coming out of the
laser head.



Air flow is set by turning the knurled
shafts at the bottom of the Air-assist
Control on the left side of the laser
as shown in the photo.



Turning the knob CW reduces the
amount of airflow, turning it CCW
increases the amount of air.



You generally want to use high
volume on the air assist for cutting,
and low volume for engraving.



Setting which air assist is used in
the LightBurn software is covered in
this video. Basically if you turn air
assist off in software it uses the low
pressure, turning it on in LightBurn
uses high flow.
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Step 21 — Position the laser head for your material

  

This is a very important step which if not followed can ruin your project or waste material!

You will want to set the position of the laser head so it starts at the upper left hand corner of the
piece you are cutting. Go into the Lightburn window, select the click-to-position (Move Laser) tool
and click on the upper left corner. It should be marked by a green box.



The laser head will move to this position. Make sure it is on your material and the head won't hit
a magnet or other obstruction! This is shown in the second image.



Now move the click-to-position tool to the lower right corner of your drawing and click again.

Again the laser head will move to this position and you will verify it is on the material and won't
hit any obstructions. The third image shows a case where the project is too big for the material
chosen.



Finally in the laser window press the Frame button. The laser head should trace out the outline of
the area of the selected layer. Make sure the design fits your material.



IMPORTANT - Move the head back to the upper left corner of your drawing which will be the
starting cutting position.
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Step 22 — Starting your cut

  

The laser can catch materials on fire. Once you start your cut you must watch for fires and may
not leave the area! Go to the bathroom now or get a snack before you move on!



Call up the Laser menu. Again you may need to use Window → Laser to see it.

Double check to make sure the laser head is in the upper left corner of the area you want to cut
your material in.



In the Laser window of LightBurn make sure the starting point is set to Current Position and the
radio select button in the 3x3 grid is also in the upper left corner is selected.



These two settings tell the laser where to start cutting. You can cut on other parts of your
material by changing them, but if they aren't right you can waste material.



Important: Set the origin on the laser: Go to the laser control panel and press "Origin" as
shown in the second image which will tell the laser the current position of the head will be
treated as the origin.



When you are sure everything is ready and the lid is closed. Hold Shift on the keyboard and
simultaneously press the Send button and the laser should immediately start cutting. If it
does not, press the brown start button on the laser control panel.



If there are any issues or flame, hit the emergency stop button!
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Step 23 — Optional - No Enough Extend Space error

The "No enough extend space" error
might show up, and that's because
there's not enough space for the
cutter to accelerate/deaccelerate.



Try one or multiple of the following:
1. Move the image closer to the
center. 2. Make the image larger. 3.
Slow down the speed



Step 24 — Removing the Design When Finished

The laser should do any engraving
first followed by cuts if you got the
layers set in the right order. The



Getting Started with Thunder Laser - Key… 2022-01-20[minor]v 1.2Release:Guide ID: 170 -

This document was generated on 2022-02-02 05:24:09 AM (MST).

© 2022 bucknellmakers.dozuki.com/ Page 25 of 28



video shows the laser etching the
surface of leather for the keychain
project.

After the cut is finished the laser
head will move back to the set
origin.



Wait about one minute, for any
smoke to clear, then lift the lid and
remove the design, making sure not
to hit the Laser head along the way.
Use the control panel buttons to
move the laser head or drop the bed
if you need to. Be aware that if
you're cutting, your design is no
longer attached to the larger piece of
material.



Now that you're done cutting, you
can turn off the Laser Switch then
the Main Switch.



If you are working with wood, there
is a good chance that as you move
the design/material, you will see
smoke. Do not worry too much about
this.
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Step 25 — Cleaning Up

 

When your design and the excess material has been removed, place the excess back to where the
laser cutter material is, unless you are using your own custom material or there is no good space
left on the sheet you used.



Clean the bed of the cutter for other people to use in the future. Make sure any pieces of material
that are stuck in the grid get pushed out to avoid a fire hazard!



Close the lid of the cutter and double check to make sure it is turned off when you are done
cleaning up.
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Step 26 — You are now certified!

Congratulations! You have just cut out your first design on the Thunder laser cutter!

Show your keychain fob to one of the MakerE Techs and ask them to certify you for using the
ThunderLaser.



See some of our other tutorials for more advanced cutting and engraving ideas.
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